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Abstract

High-temperature latent heat thermal energy storage with metallic alloy phase change materials (PCMs) utilize the high latent heat
and high thermal conductivity to gain a competitive edge over existing sensible and latent storage technologies. Novel macro-
porous latent heat storage units can be used to enhance the limiting convective heat transfer between the heat transfer fluid and
the PCM to attain higher power density while maintaining high energy density. 3D monolithic percolating macro-porous latent
heat storage unit cells with random and ordered sub-structure topology were created using synthetic tomography data. Full 3D
thermal CFD simulations with phase change modeling was performed on 1000+ such structures using effective heat capacity
method and temperature and phase dependent thermophysical properties. Design parameters, including transient thermal and flow
characteristics, phase change time and pressure drop, were extracted as output scalars from the simulated charging process. As
such structures cannot be parametrized meaningfully, a mesh-based Geodesic Convolutional Neural Network (GCNN) designed
to perform direct convolutions on the surface and volume meshes of the macro-porous structures was trained to predict the output
scalars along with pressure, temperature, velocity distributions in the volume, and surface distributions of heat flux and shear
stress. An Artificial Neural Network (ANN) using macroscopic properties - porosity, surface area and two-point surface-void
correlation functions - of the structures as inputs was used as a standard regressor for comparison. The GCNN exhibited high
prediction accuracy of the scalars, outperforming the ANN and linear/exponential fits, owing to the disentangling property of
GCNNs where predictions were improved by the introduction of correlated surface and volume fields. The trained GCNN behaves
as a coupled CFD-heat transfer emulator predicting the volumetric distribution of temperature, pressure, velocity fields, and heat
flux and shear stress distributions at the PCM-HTF interface. This deep learning based methodology offers a unique, generalized,
and computationally competitive way to quickly predict phase change behavior of high power density macro-porous structures in a
few seconds and has the potential to optimize the percolating macro-porous unit cells to application specific requirements.
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1. Introduction have two orders of magnitude larger conductivities. The higher
) ) thermal conductivities of metals make the convective heat trans-
Innovative energy storage technologies are necessary for ef-  for rate from the HTF to the PCM encapsulations the limiting

fective and efficient utilization of existing energy sources and its factor for dis/charging rates [6, 4]. Due to the extensive use of
integration with renewable energy sources. With over 50% end  ybylar heat exchangers and their ease of manufacture, latent
energy usage being heat [1], thermal energy storage is essential heat storage has often (around 70% of the time [7]) been inves-

in this transformation with high-temperature industrial heatbe-  (jgated in cylindrical encapsulation geometries. Heat transfer
ing particularly interesting targets. Latent heat storage utilizes enhancement strategies have centered around creating internal
the isothermal solid-liquid phase change process to store ther- or external fins [8, 9, 10]. While low conductivity PCMs are
mal energy where charging and discharging of a latentheat stor-  jimjted by the conductive heat transfer inside the PCM storage

age is performed using the flow of a heat transfer fluid (HTF)  ypjts, high-conductivity PCMs require PCM-HTF convective
around the Phase Change Materials (PCMs) enclosed within  Leat transfer enhancements outside the storage units.

high melting point encapsulated structures. High energy and
power density applications are achievable in high-temperature
latent heat storage by replacing the commonly used molten salts
and organic acid PCMs with metals or alloys [2, 3, 4, 5] that

The use of engineered porous structures for heat transfer en-
hancement either as metal matrix-PCM composites for low-
conducting PCMs or as external layers for high-conducting
PCMs is well known. Experimental and numerical studies us-
ing high porosity (0.88 - 0.96) porous metal matrices with a
*Corresponding author: Tel.: +41 21 693 38 78 low-conducting PCM like paraﬁin [11, 12, 13, 14] or n-eicosane
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to 44 times increase in thermal conductivity, with a more uni-
form temperature distribution throughout the PCM. A numeri-
cal study of external metallic porous layers surrounding metal
cylinders with air as HTF [16] demonstrated increased heat
transfer rate dependent on macroscopic parameters such poros-
ity, permeability, and thermal conductivity of the porous layer,
at the expense of a larger pressure drop requiring optimization
of the porous media parameters. Higher porosity has been ex-
perimentally verified [17] to increase Nusselt numbers i.e., heat
transfer rates and decrease pressure drops due to enhanced per-
meability. However the effect of pore density and other param-
eters was not explicit with a clear dependency on the Reynolds
number in porous media of porosity 0.90-0.94 and pore densi-
ties 20-80 PPI. The often ignored pressure drops within such
porous media based heat transfer enhancements are of partic-
ular importance due to the requirement of high-pressure (and
high-temperature with metallic PCMs) pumps which increases
the power requirements and cost of a LHTES setup. Convec-
tive heat transfer and pressure drop correlations dependent on
porosity, cell density, and material have been studied in com-
bined numerical-experimental approaches. However, numeri-
cal studies predominantly concentrate on volume-averaged cor-
relations based approaches [18, 19] to obtain pressure drop and
heat transfer predictions and ignore the pore-level topology of
the porous structures themselves. The studies that focus on real-
istic depiction of metallic matrix-PCM composites [20, 21, 22]
find that the pore-level design of porous media are important to
increasing power capacity with increasing surface area or de-
creasing pore size of the foam matrix. An experimental study
of different ceramic porous structure designs [6] reinforces the
importance of clogged flows due to design or manufacturing de-
fects leading to unexpected high pressure drops and increased
thermal dispersion. The thermo-fluidic performance of a porous
media is thus dependent not only on the macroscopic properties
but also on the pore-level topology and needs to be designed
and optimized based on the application.

A numerical study of enhancing convective heat transfer be-
tween high-conducting eutectic Si-Mg alloy PCM encapsulated
in cylindrical tubes surrounded by ceramic porous media [23]
focused on optimizing the relative geometrical dimensions of
the tubes and the porous layer to increase heat transfer rates
instead of the macroscopic parameters of the porous media.
Larger layers of porous media increased the heat transfer rate
but resulted in a larger pressure drop and crucially, the loss
of latent heat energy density of the storage. A megajoule
scale test-bed demonstration of high-temperature aluminium al-
loy PCM [5] with the same SiSiC layers setup experimentally
demonstrated the importance of porous media in maintaining
a steady exhaust temperature of the HTF by increasing HTF-
PCM convective heat transfer, but resulting in a large pressure
drop and reduced latent heat storage capacity.

Utilization of porous media as heat transfer enhancements re-
duce the latent heat storage capacity and, thus, energy density
of the storage unit. Metallic percolating macro-porous encap-
sulated PCM structure of application specific optimized shapes
are a novel and promising alternative for heat transfer enhance-
ment for high-temperature latent heat storage, especially with

the advent of additive manufacturing for convoluted metals and
ceramics parts [24, 25]. In contrast to utilization of porous
fins, the energy density of the storage unit is not decreased as
the macro-porous heat transfer enhancement incorporates the
PCM within itself. High-temperature latent heat energy stor-
age can achieve higher power and energy densities using the
novel macro-porous encapsulated structures. However, the spe-
cific topology that would maximize heat transfer and energy
capacity while minimizing pressure drop is not straight forward
to determine. An optimal simulation based strategy would be
computationally and memory light for behavior prediction of
the macro-porous structures, while being flexible enough to al-
low for both global sub-structure modifications and local refine-
ments for application based optimization.

Studies on improving heat transfer using porous structures
for latent heat storage focus on parametric optimization by
manually or heuristically varying geometric properties (en-
capsulation sizes, fin diameter, fin orientation, aspect ratio of
porous fins and porous matrices, etc.) [8, 23, 26, 27, 28], or
macroscopic properties of the porous media (porosity, mean
pore size, specific surface area, etc.) [21, 22, 29], with most
studies ignoring the induced pressure drop. These investiga-
tions are based on the preconceived topology configuration as-
sumed by the researcher and parameters chosen by their expe-
rience, limiting the set of explored porous structures to a low-
dimensional design space. Density-based approaches called ad-
joint methods where material distribution within a spatial do-
main is varied based on the gradient of the fitness function
subject to design constraints have been applied in heat trans-
fer [30, 31, 32], radiative scattering [33], and in designing the
spatial layout of high-conducting fins for cylindrical encapsu-
lations in latent heat storage [34, 35, 36] to decrease phase
change times with minimum loss of latent storage volume to
fins. These methods are computationally expensive requiring
rerunning of the simulation to recompute the fitness function at
each iteration of the optimization process. One of the classi-
cal approaches to reduce the number of computations relies on
Kriging [37, 38] where Gaussian Process regressors are trained
to interpolate the fitness function based on a low-dimensional
design space parametrization. But these methods need to be
redefined depending on the problem and require retraining the
regressor for change in parametrization. While simplified opti-
mization techniques are favored for reducing design lead times,
development of computationally frugal and comprehensive so-
lutions involving topology structure of the porous media are es-
sential for computational design of percolating macro-porous
energy storage systems.

Deep learning methods are well known for learning data
representations of varying degrees of complexities and have
been used to either improve solution performance or to identify
physics. Studies on the former assume the physics required for
the modeling and use deep learning methods to accelerate sim-
ulations such as replicating Reynolds Averaged Navier-Stokes
(RANS) flow modeling [39] or replacing the computationally
expensive steps in a Poisson flow solver [40]. Physics-based
neural networks [41] that incorporate the explicit constraint of
the Navier-Stokes equation in the loss function of the neural



network have also been used for full fluid flow partial differ-
ential equation (PDE) modeling in turbulent Rayleigh-Bénard
flows [42], quantify flow and heat fields from data measure-
ments [43], and in solid-liquid phase change problems [44].
Physics identification deep learning methods are unsupervised
learning techniques used to recognize underlying correlations
such as using Convolutional Neural Networks (CNNs) to pre-
dict the local heat flux in turbulent channel flows with wall shear
stress and pressure as inputs [45], to regress steady state veloc-
ity in a 3D domain using only the boundary conditions and ob-
ject shape [46], with a 292x speedup that increases with batch
size.

Artificial Neural Networks (ANNs) have been applied in
porous media for autonomous characterization of 3D porous
samples [47, 48], They have been used often for perform-
ing feature selection of macroscopic and pore-network proper-
ties to optimally characterize permeability of the porous media
[49, 50, 51, 52, 53] using 3D images from CT-scans. In ther-
mal applications context, ANNs have been used to predict the
oxygen output in a solar-driven porous thermochemical reac-
tors based on their macroscopic properties [54], and to predict
radiative properties within 2D opaque and transparent porous
media and packed beds [55, 56] to replicate the computation-
ally expensive Monte Carlo ray tracing-based results. The 3D
CNN has been used to predict the steady state solution of the
Navier-stokes laminar flow equation in a porous structure [57]
with macroscopic features (Euclidean distance, maximum in-
scribed sphere size, and time of flight) and the binary images
as inputs. It was shown that the 3D CNN trained with sphere-
packed porous structure could predict velocity fields in other
synthetic geometries, and in X-ray derived structures of sand-
stone and carbonate with 75% to 98% accuracy. However, uti-
lization of 3D CNNs for training results in either a coarse space
discretization or a large memory footprint making them com-
putationally expensive to train, while also not being an ideal
framework for topology optimization.

While porous media can be characterized using macroscopic
properties, a unique parametric description cannot be provided
which makes exploring this vast high-dimensional domain chal-
lenging. Geodesic Convolutional Neural Networks (GCNNs)
have been shown to reliably emulate a 3D CFD simulator [58]
by directly performing convolutions on the surface and volume
meshes of the macro-porous unit-cells. GCNNs are thus well
suited for training and optimization of structures that cannot
meaningfully be parametrized and thus are outside the purview
of manual and heuristic prediction and optimization methods.
While training of such GCNNs are typically in the order of tens
of hours, predictions are obtained in seconds and application
specific structures can be obtained in the matter of a few min-
utes. Turbulent aerodynamic characteristics of aerofoils and
cars have been predicted with 86% accuracy and utilizing a
gradient-based optimization on the GCNN to move the vertex
positions of the mesh and optimize the aerofoil/car shape [58].
GCNNe s are particularly attractive for the characterization of the
3D percolating macro-porous latent heat storage unit cells as
the surface and volume mesh vertex positions themselves can
be used as parametric descriptors of the structure.

The specific objectives of this study is to utilize deep learning
techniques to predict the heat transfer behavior of the percolat-
ing macro-porous latent heat storage unit cells, as a first step
towards free form optimization. The specific steps followed in
this paper to achieve this are:

1. Create a computational framework for generation of re-
alistic percolating macro-porous latent heat storage unit-
cells with customized macroscopic properties and ran-
dom/ordered sub-structures.

2. Perform transient 3D thermal CFD phase change sim-
ulations on the macro-porous unit-cells with a high-
temperature aluminum alloy as the PCM and air as the
HTF to assess the thermal and flow characteristics during
the charging process of the latent heat storage.

3. Demonstrate the utilization of a GCNN to predict the melt
time and pressure drop in the flow through the macro-
porous unit-cells, with the predictions improved over a
simpler ANN using fields from the volume domain and
the PCM-HTF interface fields.

2. Method

2.1. Macro-porous Unit-cells Generation

The procedure of generating computational fluid dynamics
(CFD) meshes for macro-porous unit-cells with random and or-
dered sub-structures from a 3D stack of artificial tomography
data are detailed in Fig. 1. For the random sub-structures, a
stack of random pixels images 150 x 150 x 400 pixels®, shown
in Fig. 1a, was generated by randomly assigning binary values
(0 or 1) at each voxel. The size of the stack is large enough
to represent a periodic cell of the macro-porous structure with
a wide range of porous sub-structure length scales while be-
ing limited by the memory for further conversion into meshes.
This stack was passed through a 3D Gaussian filter with dif-
ferent kernel sizes (between 5 and 30 pixels) depending on the
length scale of the porous sub-structures required and normal-
ized. A final porosity filter acts as a threshold to generate a 3D
image stack of the structures with the required porosity. This
process of generating random sub-structures was automatized
to generate 1163 3D meshes with varying sub-structure length
scales and porosity as detailed in the Section 3.1, as the accu-
racy of GCNNSs has been observed to plateau only with sample
numbers larger than 1000 [58]. For the ordered sub-structures,
points were positioned in a cubic arrangement separated by a
constant distance and connected by straight lines to obtain a
skeletal structure. This cubic arrangement was converted into
a stack of images 150 x 150 x 400 pixels® by adding pixelated
spheres of required strut diameters along each connecting line
in the cubic arrangement to create 3D image stacks shown in
Fig. 1b. 68 such ordered sub-structures were constructed with
different cubic based arrangements (2x2x2 to 4x4x4), range of
strut diameters (5 to 15 pixels), and cross-linkages within the
structure. To simulate a unit-cell of the latent heat storage, a
fully connected 3D percolating monolithic PCM is required to
be physically reproducible, for example by 3D printing. Using
the open source 3D image processing package Fiji [59], STL



Figure 1: Unit-cells of 3D monolithic macro-porous structures showing the dimensions, flow direction for the HTF, and the steps for generating the unit-cells with
(a) random and (b) ordered sub-structures. The simulation results on the CFD mesh generated using the structures are shown as velocity streamlines colored by

temperature, 7', and melt fraction, 3, of the PCM.

meshes were obtained from the image stacks and processed us-
ing the 3D software Blender [60] to remove the physically dis-
connected regions and obtain a monolithic surface mesh STL
file. This actually reduced 4000 initially created structures to
the 17163 structures usable for the analysis. Finally, the open
source meshing code snappyHexMesh in OpenFOAM [61] was
used to generate hexahedral meshes from the STL files with
multi-layer refinements close to the interfaces as shown in Fig.
1. Details of the generation procedure are provided in supple-
mentary section. The hexahedral meshes were scaled to the di-
mensions 5 X 5 x 13 cm? to depict realistic dimensions usable in
the LHTES setup [5], with the unit-cells generated representing
a periodically replicated unit-cell of a larger latent heat storage
structure.

2.2. Numerical Model
A 3D coupled CFD-heat transfer model developed in AN-
SYS Fluent was used to perform the phase change simulations

on the percolating macro-porous unit-cells during charging. A
similar heat transfer and phase change behavior is expected dur-
ing the discharging process. The aluminum alloy Alg74Sijze
(Wt%) [4] was used as the PCM, with air, behaving as an ideal
gas, as the HTF. We assumed:

1. The thin encapsulation layer over the structures was ne-
glected for the simulation as it does not significantly con-
tribute to the phase change evolution. Sensible heat stored
within the simulation temperature bounds with a 1 mm
thick encapsulation accounts for 4.4% of the total energy
stored in the structure for the largest surface area cases.
The contribution of the thin layer of encapsulation to the
thermal resistance is dependent on the encapsulation ma-
terial and is not considered.

2. The PCM is homogeneous and isotropic. Temperature and
phase dependent specific heat capacity and thermal con-
ductivity for Algy4Sijs ¢ during phase change (as listed in



Tab. 1) are simulated using point-wise linear interpolation.

3. The effect of buoyant convection inside the PCM is ne-
glected, according to results of high conductivity PCMs
[62, 4] at low Stefan numbers. Thus no explicit tracking
of the melt interface within the PCM was required. The
molten PCM is modeled as a solid.

4. Radiative heat transfer within the porous structure and
thermal expansion of the PCM was neglected as the ini-
tialization temperature of the simulation domain is close
to the inlet temperature of the HTF (to skip the slow sen-
sible heating of the structure) resulting in small temper-
ature differences between the macro-porous unit-cell and
the HTF.

The momentum conservation equation solved in the computa-
tional domain of the HTF is:

0
E(pairu) +V- (pairuu) =-VP+V-1 + Pair§ + F (D

where p.ir = p/Rai;T for the ideal gas, T is the shear stress
tensor, and F is the external body force from interaction with
the solid PCM domain. The energy equation in the HTF domain
is:

gt(pairhair) +V. (u(pahair + P)) =V. (kairVT) + lI (2)

where hgr = ¢p.irAT is the enthalpy of the ideal gas, and ¢
is the convective heat transfer interaction with the PCM. The
energy equation in the solid PCM domain is:

0 .
E(ppcmhpcm) =V (kpcmVT) -q 3

where enthalpy fpem = f ¢ppem dT .The phase change inside the
PCM is modeled using the effective heat capacity method which
uses an increased specific heat capacity [63] of the PCM within
the phase change temperature range to account for the latent
heat. The latent heat is assumed to be added to the specific heat
linearly with temperature during phase change:

Cps T <T;
Cp = 1 Cps +B(Cp’1 - Cp’s) + TIT T,<T<T
s
Cpl T>T

The macro-porous unit-cells were simulated for charging us-
ing a constant velocity uj, = 0.1 ms~! laminar influx (Reynolds
number of 250 based on the channel size of 5cm) of the HTF
maintained at a constant inlet temperature of T;, = 870 K with
the exit maintained at a constant pressure of poye = 1 atm. The
remaining four boundaries were set as symmetry boundary con-
dition so that the structure represents a unit periodic cell of a
larger heat storage. The simulation was initialized at 845K to
skip most of the the sensible heating part of the simulation and
thus reduce computational time. Nevertheless if the sensible
simulation was performed, the combination of a latent heat stor-
age (200x) compared to the sensible heat storage and the lim-
iting HTF-PCM convective heat transfer will result in a near-
uniform temperature within the macro-porous structure.

The simulation setup was solved in ANSY'S Fluent with set-
tings detailed in the supplementary section. The simulation re-
sults at 10’000 s, when all structures were still in the process
of phase change, were exported as temperature, T, pressure, P,
and velocity, u, distributions on a volume mesh, Xy, of size
40 x 40 x 400, and heat flux, ¢, and shear stress, 7, field distri-
butions on a surface mesh, Xgus.

The latent energy stored by the macro-porous unit-cell can
be expressed as ppemLVpem = PpemLViot(1 — @), where ¢ is the
porosity and Vi, represents the volume of the bounding box
within which the various macro-porous unit-cells are created
(5% 5x 13 cm? in Fig. 1). The mean heat transfer rate or power
can be defined as: ppcmLVpcm/tmeh = ppcmLVtol(l - ¢)/tmeh-
The melt time #y,e;; obtained from the phase change simulations
thus represents the ratio of energy to power rating of the macro-
porous unit-cell. A normalized melt time, #,om, Was used to
compare the melting time for each unit-cell for the same input
flow enthalpy of HTF:

foorm = Tmelt ) T Cp air (Tin = Tw) @)
(1 - ¢) Ppcm L Vlot

A smaller #,oy is thus an indication of a higher relative power
density of the macro-porous unit-cell.

The specific heat capacity model has been validated exper-
imentally in a previous work [5] with a test-bed for high-
temperature latent heat storage using cylindrical encapsulated
aluminium alloy surrounded by ceramic porous media. The
pressure drops calculated by the simulations have been veri-
fied to have the same order of magnitude as pressure drops ob-
tained using correlations for ceramic and metal sponges [65, 6],
cylindrical arrays [66], fibrous beds [67], and packed beds of
spherical particles [68, 69].

2.3. Deep Learning Based Physics Emulators

2.3.1. Naive Network - ANN

A fully connected artificial neural network (ANN) was cre-
ated to use as a standard regressor, with only the macroscopic
properties as input and the scalars #yeyr, fnorm and AP as outputs.
The ANN was compared with the performance of the GCNN.
The ANN shown in Fig. 2 is comprised of 8 layers with 20
neurons in each layer with ReLU (Rectified Linear Units) acti-
vation at each neuron to limit the output values of each neuron
between 0 and 1. The particular selection of layers and number
of neurons was chosen by trial-and-error to obtain the best re-
sults without overfitting (divergence of test set 7> values). Nor-
malization and scaling to unit variance was performed on the
inputs and outputs for better convergence, and Gaussian noise
was added to the inputs for regularization before training. A
least square error regularization is also performed at each neu-
ron to prevent overfitting. L2 (least square error) loss was used
for the scalars predictions. The inputs to the ANN consisted
of the macro-porous unit-cell properties, namely ¢, A, and a
two-point surface-void correlation functions, F, detailed in the
supplementary section.



Alg7 4Sijo6

. Thermal Specific Heat . .
Temperature Dens1ty3 Conductivity ~ Capacity, ¢, Viscosity
TK — plhkem™ pwmikly gke'k) — HFaS)
273 2700.0 160 1070 -
849 (Ty) 2587.5 160 1070 -
851 (1) 2460 70 1170 1.30 x 1073
950 2428.1 70 1170 1.30 x 1073

Table 1: Temperature and phase-dependent properties of Alg7 4Sij26 [2, 64] with latent heat of melting L = 470kJ kg’l.
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Figure 2: ANN architecture showing four layers of the dense (fully connected) network with ReLU activation at each neuron.
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Figure 3: GCNN architecture showing the convolutional volume and surface field networks, and the fully connected scalar network, with input/output mesh, output

fields and scalars.

2.3.2. Geodesic Convolutional Neural Network (GCNN)

A GCNN was designed to predict the output scalar values
of tmelt, thorm, and AP, obtained from the simulations. Macro-
scopic properties porosity, ¢, and surface area, A, calculated
from the macro-porous unit-cells are provided as scalar inputs
along with the meshes Xyo and Xg,r. The GCNN network ar-
chitecture has separate volume and surface field network, and
scalar network to predict the volume field outputs 7', P, and u,
surface field outputs ¢ and 7, and scalar outputs t,om and AP,

with a few initial layers shared by the field and scalar networks
connected via a mean pooling operation. The #,; Was calcu-
lated from fyorm using eqn. 4. Fig. 3 details the GCNN archi-
tecture used with intermediate level features also shown. The
volume and surface field networks constitute mesh convolution
operations at each layer, whereas the network to predict scalar
outputs is based on fully connected network layers. The data at
both, input and output, are either z-score or log normalized, de-
pending on their distribution and scaled to unit variance before



being used in the GCNN to speed up the convergence. L1 (least
absolute error) losses were used for the scalars and L2 (least
square error) losses were used for the fields, due to outliers be-
ing present in AP. The losses for the fields were weighted 5
times larger than the scalars for the combined loss to prevent
overfitting of the scalars. A larger value of the weights would
result in a delayed convergence of the r* value requiring more
iterations for training.

3. Results

3.1. Macro-porous Structure Characterization

Even though the macro-porous unit-cells cannot be explic-
itly described by a few parameters only, macroscopic proper-
ties of the structures - like ¢ and A - can be obtained. Fig.
4 shows the distribution of these macroscopic properties as a
function of fpei, AP, (¢) and (1) for each structure obtained
from the simulations. The figure also displays the topology of
a few, select unit-cells with random and ordered sub-structures.
Fig. 5 shows their distribution compared to the mean of the
volume fields (T'), (P), and (u). Figs. 4 and 5, while display-
ing the range of macro-porous structures generated using the
porous media generation technique detailed in this paper, also
depict the applicability range of the trained deep learning mod-
els used in this paper. A z-score normalization is performed on
all the variables before being input into the ANN and GCNN
networks, except for AP and P which are log normalized as
their values are spread over a large range of orders of mag-
nitudes, shown by their distribution plots in Fig. 4 and Fig.
5. Note that only a few random sub-structured unit-cells are
present in the data set at large ¢ because of the random struc-
ture generation process where several disconnected regions or
air pockets are often formed at high porosities which end up
being removed, thus generally resulting in a dataset with lower
¢ structures. Fig. 6 shows a plot of the opposing scalar out-
puts fhorm Vs AP for the random and ordered structures. The
Pareto fronts shown in Fig. 6 indicate that ordered structures
outperform the random structures. It is seen from the distribu-
tion plots of A and ¢ in Fig. 4 that there is a lack of random
structures with large A at high ¢ which could explain some
of the under-performance compared to the ordered structures.
However, the higher thermal-fluid performance of the ordered
structure is due to better heat transfer fluid flow management
preventing clogged flow sections often seen in random struc-
tures. This shows that the overall transport properties of the
macro-porous structures are not only a function of the macro-
porous properties like surface area, porosity, and cell size but
also dependent on the geometrical anomalies which can deviate
the flow path. The set of structures generated have a range of
macroscopic properties ¢ = 0.23 —0.95 and ¢ = 0.41 — 0.96,
A = 0.005-0.064 m? and A = 0.013—0.076 m? for random and
ordered structures respectively. The output scalars are in the
range fme = 13’400 — 125”100s and tyery = 6’680 — 92'830s,
AP = 0.0078 — 169 Pa and AP = 0.020 — 3.149 Pa for random
and ordered structures respectively. The data set of random and
ordered sub-structures are not exhaustive but represent a large
range of the domain of possible unit-cell structures.

The predictions by simple linear and exponential fitting for
fmer and AP are shown as red lines with 2 values in the cor-
responding plots. fney is predicted with > = 0.968 using a
linear fit with ¢ (fmerr = 153’431.62 — 1457224.92 - ¢) and
thorm is predicted with > = 0.708 using an exponential fit
with A (fyorm = 1.0152 + 1.5310 - 7161803+ LIITy = Ap ex-
ponential fitting against ¢ for AP results in 2 = 0.200 as
shown in Fig. 4 (AP = 0.1293 + 1.9588 . ¢ !14197¢+5.2836)
The exponential fit is much better (#> = 0.644 using AP =
—6.6097 + 1.0704 - £369922:(+1.6605y wwith () for AP. The mean
fields (P) and (u) also correlate with AP linearly r* = 0.856
(AP = 0.1284 + 3.7635 - (P)) and exponentially rr = 0.784
(AP = —2.9133 + 0.6321 - ¢!37763w+0.7963) regpectively. A
correlates exponentially with (g) > = 0.783 using (§) =
15.8302+6.9111-¢73173584+3.1070ip Fig 4) and (T') (+*> = 0.281
using (T) = 849.6496 + 1.8469 x 1072 . ¢~8+9948:4+6.5658 jp Rijg
5) which would aid the GCNN in predicting both, #,c;r and AP.
These correlations justify the usage of the volume and surface
fields in the GCNN to better predict the output scalars #;,; and
AP.

3.2. Training: ANN

The ANN was trained on a randomly chosen test set con-
sisting of 90% of the macro-porous unit-cells and the remain-
ing 10% of the unit-cells constituted the test set for validation
and overfitting check of the model. The scalars #eit, fnorm and
AP were predicted individually using separate ANNs. Train-
ing was performed with different inputs: with only ¢ and A as
inputs named as ANN-scal, and with F, correlation function
additionally as input named as ANN-corr. Training was per-
formed for 2000 iterations (around 4 to 5 minutes on a single
NVIDIA GeForce GTX 750 Ti GPU) with batch sizes of 30 for
both the models, with ANN-scal and ANN-corr, consisting of
around 3000 to 4500 parameters to fit during training.

The results of the trained ANN-scal and ANN-corr are shown
in the ground truth vs prediction plots of Fig. 7, where per-
fect predictions with 7> = 1 results in all the points coinciding
with the dashed diagonal line. fpelr, thorm, and AP are better
predicted (with an increase in accuracy of 1.76%, 14.3% and
125.5%) using the ANN-corr compared to the linear/exponen-
tial fitting with the input scalars. The predictions of #,,, and
AP were improved by using F';, correlation values in addition
to ¢ and A as observed when comparing Fig. 7c and Fig. 7f.
The set of 75 F, correlation values provided a succinct numer-
ical representation of the macro-porous unit-cell to the ANN in
addition to the ¢ and A values, which improve the predictions
of the output scalars #yeit, fhorm, and AP (by 0.1%, 5.20%, and
173% compared to the ANN-scal, respectively). Attempts of
using other macroscopic properties like tortuosity, mean pore
diameter, chord lengths, etc., or two-point functions such as
void-void, and surface-surface correlations [70] did not further
improve the training results. This was in contrast to a study us-
ing ANNS to predict oxygen generation in a solar-driven porous
thermochemical reactors using macroscopic properties of the
porous media observed where significant improvement in pre-
dictions were observed using the inputs tortuosity, surface-void,
void-void, and surface-surface correlations [54].
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3.3. Training: GCNN

The GCNN training was performed with a batch size of 1
(due to the limited GPU memory and large sizes of the surface
and volume meshes) for 500’000 iterations (after which the 2
values converged) with 90% of the structures used for training
set with the remaining structures used for the test set. The learn-
ing rate of 0.001 which exponentially decays to 0.9x its value
every 10’000 steps was chosen such that the parameters of the

network are explored in a large enough domain while maintain-
ing stable convergence of the training accuracy. The training
required around 300 hrs of computation on a Tesla-K80 GPU
by NVIDIA. Fig. 8 shows the ground truth vs prediction plots
for the output scalars using the GCNN. The comparison of test
set prediction accuracy from the different methods - simple lin-
ear/exponential fitting, ANN-scal, ANN-corr, and GCNN are
summarized in the Table 2.
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The output scalars #eir, fnorm, and AP are all better predicted
(with increase in accuracy of 2.38%, 6.78%, and 352%) us-
ing the GCNN compared to the linear/exponential fitting. The
prediction of AP outperforms the ANN-corr by a large mar-
gin, due to the presence of the volume and surface field net-
works which act as regularizers for the fully connected scalar
networks and also prevent overfitting by adding correlated in-
formation to train an ill-posed problem. Note that the training

sets in GCNN (Fig. 8) for both the output scalars are better pre-
dicted than the training sets in ANN (Fig. 7), which emphasizes
the importance of fields being trained alongside the scalars. Us-
ing fields as regularizers and forcing the network to learn data
consistent and relevant to the predictions has thus been found to
be helpful to better train the network while preventing uncon-
trolled extrapolation of the output scalars. This technique of
improving learning by predicting additional relevant quantities
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Model fmelt fnorm I'xp rr rp Ty T, 2 rr
Linear/Exponential Fit 0.968 0.708 0.200
0984  0.769 0.165
ANN-scal (1.65%) (8.62%) (-17.5%)
0985  0.809 0.451
ANN-corr (1.76%) (14.3%)  (125.5%)
GONN 0991  0.756 0904 0930 0.605 0.142 0695 0.210
(238%)  (6.78%) (352.0%)

Table 2: Comparison of test-set prediction accuracy of the different scalars, volume and surface fields using simple fitting, ANN and GCNN. The increase or
decrease in accuracy over the linear/exponential fitting is shown in percentage below the > values.)
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Figure 6: fyer and AP values from the simulations for the different macro-
porous unit-cells with random (circles) and ordered (diamonds) sub-structures.

through connected training branches, called disentangling [71],
has been studied for deep learning applications such as facial
recognition [72] and drug-discovery [73]. Disentangling also
results in intermediate level features (as shown in Fig. 3) is less
prone to overfitting.

In addition to predicting the required scalars, Figs. 9 and
10 demonstrate the usage of the GCNN as a coupled CFD-
heat transfer emulator comparing the ground truth, prediction
and the relative difference percentage error (at each node in the
mesh) for volume and surface fields in two macro-porous unit-
cells, a random and an ordered sub-structure both located on
the Pareto front of Fig. 6. The prediction accuracy are listed
for each figure and averaged for all samples in the Table 2.
On average, the T fields are predicted with high accuracy of
93% followed by ¢ at 69.5% and P at 60.5%. Large predic-
tion errors up to 57% in P field predictions are observed at the
domain inlet as shown in Figs. 9b and 10b, where higher P
values are present in the domain. The average prediction accu-
racy is lower (14.2%) for u fields with errors observed after the
macro-porous structure due to formation of vortices and back-
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flows from the exit. Larger errors for u fields are observed for
the ordered structure (for example in Fig. 10c) due to higher
velocity values observed in the ordered structures with high ¢.
Prediction accuracy of 7 correlated with the u fields and were
also low, averaging at 21.0%. The predictions for P, u and 7
can be improved either by using additional volume field scalar
inputs like time of flight [57], adding data about the shortest
distance of points in the domain from the inlet [74], or by using
physics based GCNNs - for example, by adding loss functions
based on correlations between the u, T and P fields. Neverthe-
less, these results obtained from the test sets confirm that the
GCNN architecture is learning physical phenomena as a cou-
pled CFD-heat transfer emulator and not just interpolating the
volume and surface fields.

The trained GCNN can thus be used as a surrogate model or
proxy for the 3D CFD simulator to evaluate the outputs, i.e., T,
P. u, g, T, tyelts thorm» and AP. Although the intermediate level
features of the GCNN predict volume and surface distributions,
they are training dependent and do not represent any mean-
ingful physical quantity of the modelled system. Meaningful
physical intermediate features could be created in physics based
GCNN models where Navier-Stokes based loss functions are
used [42]. The GCNN network, being a combination of linear
regressors, is differentiable with respect to coordinates of the
vertices in the Xy, and Xyo, meshes. A gradient-based tech-
nique can further be used to minimize both the pressure drop
and normalized melting time by moving the mesh vertices in
contrast to the ANNs which do not consider explicit geometric
information of the structures. Ordered and random structures
on the Pareto front of Fig. 6 could be modified using 3D Gaus-
sian kernel based movements added on randomly chosen ver-
tices of the structures. Heuristic optimization methods can be
used to choose the structures based on the optimization fitness
criteria and modify them further. The optimization process can
also incorporate design constraints such as limiting the ¢ to a
given range, the presence of contacts on all four walls of the
unit-cell, sustaining a minimum distance between the mono-
lithic mesh vertices to maintain minimum thickness of the per-
colating macro-porous unit-cells, space allowance for addition
of encapsulation, and prevent obstruction to the HTF flow. The
trained GCNN network predicts the specific scalars and fields
at a particular time step with specific boundary conditions. The
GCNN could be generalized to further include boundary con-
ditions and thermal properties of the PCM and HTF as inputs
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to the network. A combination of the GCNN and the time- to also extend the GCNN application as a surrogate transient
series predicting Recurrent Neural Networks [75] can be used CFD simulator which will also lead to better prediction of the
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scalars. The L1 and L2 losses used in the current GCNN can
be replaced by physics based losses to substantially improve
predictions of the fields and thus the scalars.

4. Conclusions

We created novel artificially generated percolating macro-
porous periodically replicating unit-cells of latent heat storage
systems with random and ordered sub-structures. 3D image
stacks of artificial macro-porous structures were produced us-
ing combination of random 3D Gaussian filters and ordered cu-
bic point and cross-linkage arrangements to obtain 1163 ran-
dom and 68 ordered unit-cells with a wide range of macroscopic
properties (¢ = 0.23 — 0.96, A = 0.005 — 0.076 m?) and sub-
structure length scales.

As the macro-porous unit cells cannot be explicitly
parametrized, the unit-cells were characterized with respect to
their macroscopic properties: porosity ¢, surface area A, and
two-point surface-void correlation functions Fy,. The image
stacks were used to obtain 3D CFD hexahedral meshes and
used to simulate a transient charging process with Algy 4Sijze
as the PCM and air as the HTF using effective heat capacity
method. The simulations output scalar values were: melt time
fmelt, Normalized melt time #,o:m and pressure drop AP which
are the principal design characteristics for a latent heat storage.
The simulation fields output on the PCM-HTF interface surface
were: shear stress 7, heat transfer rate g. The volume fields
output in the entire simulation domain were: temperature 7,
pressure P, and velocity u. Simple linear and exponential fits
using ¢ and A predicted the output scalars tyeit, fnorm, and AP
of each macro-porous unit-cell with accuracy of > = 0.968,
r> = 708 and r* = 0.200, respectively. While the #,,; was
predicted with 96.8% accuracy using the fits, f,orm (70.8%) and
AP (20%) predictions required improvements as they were not
just dependent on the macroscopic properties but also on the
topology of the structures. The unit-cell characterization using
simulation results also established that the output scalars were
correlated with the mean values of the volume and surface fields
indicating their use for improved prediction capabilities.

Artificial neural networks were trained as standard regressors
to improve the output scalar predictions, with ¢ and A used as
inputs in ANN-scal and F g, additionally used as input for ANN-
corr. While ANN-scal did not significantly change the predic-
tion accuracy, ANN-corr increased the prediction accuracy for
tmelt BY 1.76%, tyorm by 14.3%, and AP by 125.5%. The addition
of the two-point surface-void correlation functions F'y, provides
the network with data pertinent to the surface topology of the
unit cells.

A geodesic convolutional neural network (GCNN) was
built consisting of convolutional network branches for vol-
ume meshes and surface meshes, and fully connected network
branches for prediction of the output scalars with the multiple
branches connected via shared initial layers. The volume and
surface mesh of the unit-cells are used as inputs along with
¢ and A as input scalars. The network was trained to emu-
late a coupled CFD-heat transfer simulation by predicting the

13

volume and surface fields, along with the scalar outputs. Sig-
nificant increase in prediction accuracy was demonstrated for
tmelt (2.38%), thorm (6.78%), and AP (352.0%) compared to the
simple fits, outperforming the artificial neural networks. The
GCNN demonstrates the disentangling property of neural net-
work where improvements in training and regularization of pre-
dictions were observed by forcing the network to learn addi-
tional data relevant to the output scalars.

The well trained GCNN model represents a lightweight ver-
sion of simulation software with the advantage of predicting
phase change behavior instantly for different geometries. The
framework can be further extended to predict different bound-
ary conditions by using them as inputs, while encountering
physical phenomena such as turbulence at higher velocities. As
the network represents a massive combination of linear regres-
sors, work is ongoing that applies gradient-based techniques to
optimize the structure of the surface mesh topology for opti-
mized or required combinations of the output scalars.
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Nomenclature

Abbreviations

ANN  Artificial Neural Network

CFD  Computational Fluid Dynamics

GCNN Geometric Convolutional Neural Network
HTF  Heat Transfer Fluid

LHTES Latent Heat Thermal Energy Storage

PCM  Phase Change Material

English symbols

AP pressure drop Pa
7 mass flow rate kgs!
q heat flux Wm™?
err Relative difference error %
A surface area m?
p specific heat at constant pressure Jkg ' K™!



F force Nm™
F,, two-point surface-void correlation -
g acceleration due to gravity ms™2
h specific enthalpy Jkg™!
L latent heat of melting Jkg™!
P pressure Pa
r? coefficient of determination -
T temperature K
tmelt melting time S
thorm  normalized melting time -
u velocity ms™!
v volume m3
k conductivity Wm™! K
Mathematical Functions

v Gradient function

A Difference function

() Mean value function

Greek Symbols

B PCM liquid/melt fraction (%) -
I'(x)  void indicator -
1) porosity -
II(x)  surface indicator -
o density kgm™
T stress-strain tensor Nm™

Subscripts

air air /| HTF

1 liquidus point PCM
pcm  PCM

s solidus point PCM
tot total
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6. Supplementary Information

6.1. Macro-Porous Structures Generation

The macro-porous structures are created from 3D stacks of
artificially generated tomography data.

6.1.1. Random sub-structures

The tomography data for the random sub-structures can be
created as shown in the Fig. S1 which starts with a stack of
binary images with randomly assigned pixel values of 0 or 1
(Fig. Sla). 3D Gaussian filters of required kernel sizes (stan-
dard deviations) in the three coordinate directions are applied
to the binary images to generate the structures depending on
the length scale of the porous sub-structures required and the
images normalized. The structure of required porosity is then
generated using a threshold filter (Fig. S1b).

6.1.2. Ordered sub-structures

The tomography data for the ordered structures are created
using a slightly different method. As shown in Fig. S2, a set
of points were placed in a cubic arrangement separated by a
constant distance and connected by straight lines (both with
and without diagonal connections) to obtain a skeletal structure
(Fig. S2a). Pixelated spheres of required strut diameters are
added along each connecting line in to create 3D image stacks
shown in Fig. S2b. Multiple ordered structures as shown in Fig.
S3 were created.

6.1.3. STLs from 3D image stacks

The image stacks are process to obtain 3D STLs in the open
source 3D image processing package Fiji [59]. Blank 3D stacks
of images are added at the top and bottom ends of the generated
structures stack to account for the inlet (150 150 %220 pixels®)
and outlet (150 x 150 x 400 pixels®) lengths. The size of the fi-
nal 3D image stacks generated including the inlet and outlet is
thus 150 x 150 x 1020 pixels®. The following instructions are
for the version Fiji ImageJ 1.53f51. The 3D stacks are opened
in Fiji by ’File > Import > Image Sequence’. Gaussian 3D fil-
ters are added via ’Process > Filters > Gaussian Blur 3D’ with
sigma of 1 pixel in all directions, so that the final STL surface
is smooth. Using "Plugins > 3D Viewer’ with the settings for
the surface display shown in Fig. S4. The generated STL is
exported by ’File > Export Surfaces > STL (ASCII)’. The open
source 3D software Blender [60] was used to remove the phys-
ically disconnected regions by going into the 'Edit Mode’ and
"Mesh > Clean up > Delete Loose’. The loose parts are re-
moved from the STL to obtain a monolithic surface mesh STL
file for the PCM-HTF interface of the macro-porous structure
shown in Figs. S1c and S2c.

The 3D STLs were used to create CFD hexahedral meshes
shown in Figs. 11d and 12d using the open source meshing
code snappyHexMesh in OpenFOAM [61] with multi-layer re-
finements close to the interfaces.

The CFD mesh generated can be used directly for perform-
ing simulations in OpenFOAM or in ANSYS Fluent as shown
in this thesis. The mesh is converted to the Ensight format
using the command foamToEnsightParts which generates a
folder with the name "Ensight’. The mesh can be imported into
ANSYS Fluent by opening the "Ensight.case’ file in the folder
via "File > Import > Ensight’.

6.1.4. Simulation Settings and Data Processing

The simulation setup was implemented and solved in AN-
SYS Fluent with the energy, mass, and momentum conser-
vation equations discretized using the second order upwind
scheme and time formulation using first order implicit scheme.
Pressure-velocity coupling in the continuity equation was dis-
cretized using the PIMPLE method with under-relaxation fac-
tors (0.85 for pressure, 0.85 for momentum, 0.85 for the melt
fraction) and unscaled residuals of 107 for mass, 10~ for mo-
mentum and 1078 for energy. Time and mesh convergence
studies were conducted and chosen for convergence and com-
putational efficiency. The phase change simulation for each
macro-porous structure had a running time ranging from 9 to
20 hours on 15 CPUs and 40GB RAM depending on the poros-
ity and the complexity of the structure. The GCNN utilized
for this work [58] considers the volume and surface meshes of
the porous structure along with vertex locations and their con-
nectivity as a tensor input. The tensor form of this input in
GCNNs while results in efficient usage of modern tensor based
computational hardware, leads to higher memory usage with
larger and complicated meshes. This is similar to the scaling
problem encountered with 3D CNNs used on binary images.
While a hexahedral mesh created using snappyHexMesh with
smaller elements closer to the surface to better resolve the flow
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Figure 11: Generation steps of unit-cells of 3D monolithic macro-porous structures with random sub-structure showing (a) 3D image stack with randomly assigned
pixels, (b) 3D image stack after applying 3D Gaussian filters and threshold to choose required porosity, (c) STL created from the image stack, (d) CFD compatible
hexahedral mesh, and (e) simulation results showing the dimensions, flow direction for the HTF, velocity streamlines and heat flux on the PCM-HTF interface.
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Figure 12: Generation steps of unit-cells of 3D monolithic macro-porous structures with ordered sub-structure showing (a) cubic skeletal structure, (b) conversion
to 3D image stack using pixelated spheres traversing the skeleton, (c) STL created from the image stack, (d) CFD compatible hexahedral mesh, and (e) simulation
results showing the dimensions, flow direction for the HTF, velocity streamlines and heat flux on the PCM-HTF interface.
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[2, 2, 3], sphereRad = 10, percRandom = 0, and typeLines = (a) O for cubic

structures, (b) 1 for cubic structures with slashes, (c) 2 for cubic structures with slashes placed in arrow shapes, and (d) 3 for cubic structures with crosses.
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Figure 14: Settings for the *3D Viewer’ plugin of Fiji to generate the STLs from
the 3D image stacks.

and heat transfer is preferred for simulations, mesh convolu-
tion operations run faster with uniform quality, general shape
poly-cube mesh. The uniform volume and surface meshes were
obtained using interpolation from nearby node values of the
original mesh. The surface mesh composed of triangles and
quadrilaterals was re-meshed by projecting vertices of a cubic
poly-cube mesh onto the original shape of the macro-porous
unit-cells [58] before being used as inputs for the GCNN. The
simulation results at 10’000 s, when all structures were still in
the process of phase change, were exported as temperature, 7',
pressure, P, and velocity, u, distributions on a volume mesh,
Xyol, Of size 40 x 40 x 400, and heat flux, ¢, and shear stress, 7,
field distributions on a surface mesh, X, of 70’000 equidis-
tant points, both limited by the memory of the GPU used.

6.1.5. Two-point Correlation Functions
The inputs to the ANN consisted of the macro-porous unit-
cell properties, namely ¢, A, and a two-point surface-void cor-
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relation functions, Fy,. The correlation function is based on a
void indicator function I'(x) and surface indicator function I1(x)
[70] defined as:

1, if x is in HTF phase
Moy={ > o2 EPae 5)
0, if xisin PCM domain
I(x) = |[VI(x)l (6)

By this definition, ¢ = (I'(x)) and A = (I1(x)), where ( ) signi-
fies the calculation of the mean value. The two-point surface-
void correlation function F, at different voxel distances, ¢, is
given by [70]:

Fy(¢) = (H)I(x + ¢)) (N
F,, values was calculated for ¢ = 1 to 75 for each structure as

the number of pixels in the binary images was 150 in the sym-
metrical directions of the replicating macro-porous unit-cell.
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